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i P INTRODUCAO

Este eBook foi desenvolvido com o objetivo de facilitar o seu aprendizado de maneira
didatica sobre o processo de fechamento de arquivo para producdo grafica, desde os passos iniciais
até a finalizacdo do trabalho para o PDF/X-1a usando o software da sua preferéncia.

Colocamos todo nosso know-how e experiéncia no mercado grafico ao seu dispor.
Ficaremos honrados caso vocé desejar contribuir com a sua experiéncia nesse eBook.

Sou Designer Grafico formado pela Escola Panamericana de Arte e Design, trabalho no
suporte profissional da Grafica.Design, que é uma grafica online, onde entregamos +- 5.000 itens
por dia em servigos graficos em todo Brasil e oferecemos +- 670 enderecos para retirada de pedidos
espalhados em todos os estados, inclusive em aeroportos.

“Quero, ao seu lado, entregar mais e melhores resultados aos seus clientes.
N3o é so ensinar, é transformar profissionais graficos.”

Quando falo em servigos graficos falo em cartfes de visita, envelopes, postais, sacolas,
embalagens, enfim, uma grande variedade de itens em linha de producdo. Seja em grande ou
pequena quantidade. Mesmo tendo essa performance toda, ndo produzimos todos os tipos de
material ou ainda agueles que ndo estejam dentro da nossa linha de producao.

Como consequéncia de todo esse tamanho, diversos profissionais me ligam com
dificuldade em entender alguns ajustes técnicos. E para explorar melhor esse conhecimento,

£ criamos o Congresso Nacional de Producdo Grafica onde abordamos os assuntos especificos
CO NAG RAF I C sobre cada item de produgao grafica que produzimos ou nao explicando os seus porques.
CONCRESSO NACIONAL DE PRODUCAD CRAFICA  Porexemplo, como enviar um arquivo com aplicagdo de Hot-Stamp. No congresso
www.CoNaGrafica.com.or também havera entrevistas e tutoriais justamente para levar uma informacao
ONLINE E GRATUITO mais completa,

Membro Fundador /5empreque precisar, conte comigo.
Ligacao Cratuita 0800-042-0044 /ﬁf T
Direto (11) 2368-0076 / 3042-2368 *’F/Jé}’/ Luiz Ourives
Whatshpp (1 1) 997-977-97 4 =l
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e 9 SOLUCOES

GRAFICA ATUAL CARD
http://producao.grafica.design/
Nosso site de servigos online, destinado para profissionais da area e
outras graficas, apresenta diversos itens graficos como solugdo para vocé
apresentar ao cliente (cartes de visita, pastas, adesivos, ...). A nossa base
principal é formado por prazo, preco e qualidade. No momento da
formaliza¢dao do pedido vocé podera escolher retirar em um de nossos +- 670
enderecos espalhados pelo Brasil incluindo em aeroportos (Seja um parceiro
MaisLog em http.//grafica.design/sejaparceiro) ou ainda solicitar entrega no
endereco do cliente ou no seu mesmo por precos a partirde RS 10,00.

R Entre para Comunidade WDL
WEDOLOGOS CONCORRENCIA CRIATIVA  Designer e ganhe dinheiro 555
http://arte.grafica.design/ http://Grafica.Design/WeDesign
Nosso site para servicos de arte, criacdo & design. Ainda nao tem um
logotipo? Ou ainda deseja reformular o seu atual, faca online conosco e vocé
podera ter uma nova identidade visual, sua imagem, no caso para pessoas
fisicas (empreendedores e profissionais liberais), ou ainda umaimagem
mais moderna e atualizada para sua empresa. Criamos Slogan,
Mascotes, Uniformes, .... enfim, uma série de servicos. O
melhor de tudo é que te oferecemos a garantia total.
Satisfacdo garantida ou seu dinheiro de volta. Servigos
de arte a partirde RS 65,00. Consulte.
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A cor é uma percepgao visual provocada pela agdo de um feixe de
fotons sobre células especializadas da retina, que transmitem através de
informagdo pré-processada no nervo optico, impressdes para o sistema
nervoso.

Quando se fala de cor, ha que distinguir entre a cor obtida
aditivamente (cor luz) ou a cor obtida subtrativamente (cor pigmento).

No primeiro caso, chamado de sistema RGB, temos os objetos que
emitem luz (monitores, televisdo, projetores, etc.) em que a adicao de
diferentes comprimentos de onda das cores primarias de luz Vermelho (R),
Verde (G) e Azul (B) formam as cores.

No segundo sistema, o CMYK (subtrativo ou cor pigmento), iremos
manchar uma superficie sem pigmentac¢ao (branca) misturando-lhe as cores
Ciano (C), Magenta (M), Amarelo (Y) e Preto (K).

CYAN (Ciano)

RGB, CMYK e Pantone®

RGB é a abreviatura do sistema de cores formado por
Vermelho (RED), Verde (GREEN) e Azul (BLUE) que ao se
misturarem por completo formam o branco.

ligacao Cratuita 0800-042-0044
Direto (11) 2368-0076 / 3042-2368
Whatshpp (1 1) 997-977-97 4
e-mail LUIZ@GRAFICA.DESIGN
PROFISSIONAL LICENCIADO
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dispositivos eletronicos como monitores de TV e computador, datashows,
scanners e cameras digitais, assim como na fotografia tradicional.

CMYK

CMYK é a abreviatura do sistema de cores formado por Ciano (C),
Magenta (M), Amarelo (Y) e Preto (K de Black).

O padrdao CMYK é usado para impressao. Como o CMYK que se usa na
industria grafica é baseado namistura de tintas sobre o papel e o CMYK usado
nos sistemas de computador ndo passa de uma variacao do RGB, nem todas
as cores vistas no monitor podem ser conseguidas na impressao, uma vez
gue o numero de possibilidade de cores CMYK (grafico) é significativamente
menor que o RGB. Alguns programas graficos incorporam filtros que tentam
mostrar no monitor como aimagem sera impressa. Todos os arquivos devem
ser convertidos por completo para CMYK, pois ndao imprimimos nenhum
material com cores em RGB.

CYAN (Ciano)

ligacao Cratuita 0800-042-0044
Direto (11) 2368-0076 / 3042-2368
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Pantone®

Materiais impressos utilizam o sistema de quatro cores CMYK,
enguanto que telas de computador usam o sistema RGB, e o acerto entre os
No sistema on-line de pedidaos, doi d t di a te dificil. E t ist Pant ®
Hor e haUanto s omentate A os ois _pt:: e SE‘I' extraor martam.en e dificil. nq_uan (o] quei o sistema Pantone
arquivos em CMYK, portanto funciona muito bem entre equipamentos de diferentes tipos.

é importante que o seu Pantone Inc. € uma empresa sediada nos Estados Unidos e é
arguivo seja revisado e enviado

mundialmente conhecida por esse sistema de cor. A ideia do sistema

com cores nesse padrao. ; : : H = :
SE DESEJAR PRODUZIR TRABALHOS Pantone® é escolher as cores desejadas dos guias e entdo utilizar os numeros
COM APLICACAO DE CORES para especificar de que forma é que se vai imprimir o output. Por exemplo,

PANTONE™ ENVIE PARA

R A YRR e podemos pedir a grafica que imprima o trabalho
@ . .

utilizando a cor Pantone 655 e a empresa tera
'@ .. instrucdessobre como produzira cor 655 no

& f“% seu equipamento. Desta forma, a cor
e final sera exatamente a pretendida.

Ll

A
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Selecione Localizar
qualquer modelo ou paleta
de cores. Na op¢do
Substituir pelo modelo de
cores deixe como CMYK e
na op¢do Substituir cores
usadas como use
Preenchimentos.
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Yerao Parceiro de iCorel na veia
2016.01.06 Conteddo: = RIS

COMO CONVERTER AS CORES PARA CMYK

Va até o menu
Editar > Localizar e Substituir > Substituir Objetos

3| DoterCantaXantome Cules Selecione a op¢do Substituir
P e ContafCantoine Cerie R um modelo ou paleta de cores
M8 Recoms Chrie X 1 E
B Lopis i Serja vem-vircin 5o Asmstenie de mmiiuclo,
K Coler Chrb= ¥
N I'_nlurqpeclui... anﬂf.i1mmhﬂi¢|l
I Exchuir Exehyir e o spciard 8 AllEw & orooredsdes dow chietos que |
Simpeic , i |
& Dupbcar CarieD Y '
§  Clepsr O it e G JASTS 08 S el
Subatter propredades da canets de contornn
Execistor stapa & repegir.. Ot Shalft= 0
Subwbher mopredadey de jeaia
| AQhCE GOSN B SIHETI SEEDONRIIE AT I
Impressdo sobrepoita do preenchementa
Dicas de gbjeto
Selecionar tugo ]
u.* Locglzar e substituir ¥ gy Localizar pbjetos
i Insenr cbdigo de bamas_ WA Substituir copeecs.. Ceri,
ﬂ Inxenr noye objeto...
Mraprpedades de objeto Al e Enter 1
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 Assistente de substiturgic ===

Seleyane o modeln ou paleta de cores gue voos desels
lcaizan & o modeis de cor pelo qual desels sttt o,

& Locaizar qualguer models ou paieta de cores
Lepslzer modelo e cores: HIE
Locghsir palets de cones:

| o | Bplear sos preenchamentos de padrSo de ] oores
1| t | Bt 508 IVERaRE S

Repita o processo para e e e
CORELDRAW contornos, selecionando a
opc¢ao correspondente

Selacpre o modeln ou palets de cores gue vocE deseta
eshiar & o matels de cor pelo qual desess substiba-o.

O Lpcaisar qakpe medel o paleta de cores
Logakze modelo de coves; FOH

Locpiar paieta de cones:

Subamibur Cones usadas como
: Preendpmentos @ Contormgs

/ Aghcar BOT DrewncAmMENIDE radentes
o | Aphcs sos presnchumentos de padrba de ] cores
L : I o | Apear now bitmaps monoooesiticos
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Versao Parceiro de Seja nosso
2016.01.06 Conteudo: #ParceiroPhotoShop

COMO CONVERTER AS CORES PARA CMYK
Vocé pode escolher o modo CMYK quando for abrir um novo arquivo.
Basta escolher CMYK na opgdo Color Mode (Modo de Cor).

ew T i —— =)
Mame: Nawo L—L] :
Preset: Custom - Resat |
_ Save Preset...
Wlth: 2732 Pzl -
Height: 768 Paek -
Besciutian; 72 Pioool/Tnch -
ADOBE PHOTOSHOP Color Mode: GB Coor |g) 6 bt . |
L |
i Background Contents: ;‘g‘ﬁ; | - L
| ¥ Advanied [ CMYE Cales | &, D0
Lab Coler

Também é possivel alterar o modo de cor depois que seu arquivo estiver
aberto. Primeiro confira qual modo de cor vocé esta usando.
No exemplo abaixo estamos usando em RGB.

Edit [mage Layer Type Sele
Ayt Select: Group = Show

Movo & 100% (RGB/E) =

Ligacao Gratuita 0800-042-004 4
Direto (11) 2368-0076 / 3042-2368
Uhatshpp (1 1) 997-977-97 4
e-mail LUIZ@GRAFICA.DESIGN

PROFISSIONAL LICENCIADO

B £ B B /GRAFICANAMOOCA \\Adobe COREL cPanel Bl Microsoft () @



Versao Parceiro de Seja nosso
2016.01.06 Conteudo: #ParceiroPhotoShop

Para alterar, basta acessar o menu Image (Imagem), Mode (Modo)
e CMYK Color.

Grayscale

| Adjustments

Auto Tone Shift+ Ctris Indeved Caloy...
Auto Contrast Al +Shifv+Ctrl=l | w RGB Color
Auto Color Shift+ Ctri=B CMYE Color

Lab Color

Image Soe... AltsCirle]
ADD B E PHDTD SH D P Canves Size.. Al Clrte € Multschannel
Imiage Rotation ¥ v B Bits/Channel

16 Bits/Channel
32 Bits/Channel

Trm...

Duplicate...

Apply Image...
Caleulstions...

Anakysis L,

Ligacao Gratuita 0800-042-004 4
Direto (11) 2368-0076 / 3042-2368
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ADOBE ILUSTRATOR
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Versao Parceiro de Seja nosso
2016.01.06 Conteudo; #Parceirollustrator

COMO CONVERTER AS CORES PARA CMYK
Vocé pode escolher o modo CMYK quando for abrir um novo arquivo. Basta

escolher CMYK indo em Advanced (Avancado) e escolher o Color Mode
(Mode de Cor) como CMYK,

HNovo @ 98% (RGBS Preveew] =

Também é possivel alterar o modo
de cor depois que seu arquivo
estiver aberto. Primeiro confira
gual modo de cor vocé esta usando.
No exemplo abaixo estamos
usando em RGB.
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Versao Parceiro de Seja nosso
2016.01.06 Conteudo; #Parceirollustrator

Para alterar, basta acessar o menu File (Arquivo), selecionar a opgao Document
Color Mode (Modo de Cor do Documento) e selecionar a op¢ao CMYK Color.

Ctri=M
Shift+ Ctrle M
Cpen., Cirl=0

Mew from Template..

pen Recent Files

Browse in Bridge.., Alt«Ctrl« 0
Close CrlsW
Save Crl+5
Save As.., Shift«Ctri+5
Save a Copy... Alrs Cirie 5
Save as Template...

Save for Web.., Alt+Shifte Ctris5

Save Selected Shees..
Revert F12
Place...

Save for Micresoft Office...
Export...

Scripts [

Document Setup... AR+ Cirl«P
Document Colar Mode L CMYK Color
File Info... Alts Shifts Cirle] v  RGE Color

Prnt... Ciri+P

[Exit Crr+Q
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(8 ] Pigina 1
| =& # Linko:-guin
B % = # I Comada 1
ATmc artistica: Anal (Normal) (FTE) - Preenche €0 MD Y20 K100, Contol
B [ Retingule - Presnche Menhum, Contorme: Co0 MO Y0 K100 0,200 rmm
0¥ Grupo de sembreamento - Preench: Cor de presnchimente
B Retingule - Preench: Gradients, Contome: C:0 M0 V0 K:ADD 0,200 mem|
[4 Bitmap (CMYID)
r” Curva - Presnch: Menhum, Contome: C:0 M0 Y0 K100 0,200 mm
[ Retingule - Presnch: Menhum, Contorne: C:0 MO Y0 K100 0,200 rmm [
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Versao Parceiro de
2016.01.06 Conteudo: "=tk
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Corel na Veia

DEFINICAO DE OBJETOS E SUAS CARACTERISTICAS

Os objetos nada mais sdo do que qualquer coisa utilizada na criagdo
de uma arte. Imagens, fontes, curvas, gradientes, sombreamentos e etc,
tudoisso sdo objetos e & sempre necessario tomar um cuidado especial com
cada um. Elementos como fontes devem ser convertidos em curvas,
gradientes e sombreamentos devem ser transformados em imagens e a
qualidade de suasimagens deve ser maior ou igual a 600 DPls.

Corel - Trabalhando com objetos em camadas

Para saber quais sao seus objetos e quais ou quantas camadas estao
ativas, basta abrir o Gerenciador de objetos. Aqui é possivel verificar
quantos objetos o seu arquivo tem, se possui efeitos ou textos. Também é
possivel verificar qual o modo de cor e quais cores estdo sendo utilizadas.
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| Organizar

Transformacgdes L
11" Limpar transformac fes

Alinhar e distnibuir L4
Ordenar ¥

B Blogquear objeto

Fogrmato ]

Conyerer em curvas Ctri+Q
Converter contomo em objeto Cirl+Shift+ 0

0o

Umir curvas

Ligacao Cratuita 0800-042-004 4
Direto (11) 2368-0076 / 3042-2368
Whatshpp (1 1) 997-977-97 4

e-mail LUIZ@GRAFICA.DESIGN

B £ £ B /GRAFICANAMOOCA

PROFISSIONAL LICENCIADO
I\YAdobe cOREL cPanel J§ Microsoft @ @

Versdo EIESIECEER Y Core | na Veia
2016.01.06 i

Conteudo: “:
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COREL-CONVERTENDO OBJETOS EM CURVAS

E importante converter fontes e outros objetos que nio estdo em

curvas. Para converter um objeto em curvas vocé pode ir até o menu
Organizar e selecionar a opg¢do Converter em curvas, ou acessar o menu
rapido pressionando Ctrl+Q.

NOTA IMPORTANTE:

Desde a implantacdo da tecnologia PDF/X-1a no nosso processo de
producdo, deixei de usar e RECOMENDO A VOCE TAMBEM FORTEMENTE
a deixar de converter FONTES EM CURVAS, exclusivamente a usuarios
do CorelDraw.

No passo-a-passo da configuracao do fechamento do PDF, ha um ‘tique’
que ativa a conversdo automatica de todo conteudo TEXTO do seu
arquivo para CURVAS, entao nao se preocupe.

Converter em curvas somente em casos isolados ou quando nao

ha esse ‘tique’ em outros softwares que automatizam

essa conversao.
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Mascara de cor de bitmap 1

Medo b

COM FREQUENCIA CONVERTO ARQUIVOS
EM VETOR POR BITMAP/IMAGEM
DE 1.200 DPIs QUANDO HA EFEITOS
E/OU USO DE IMAGENS DE FUNDO.
SEJA EM CARTAO DE VISITA, FLYER,
FOLHETO, POSTAL, CATALOGO, ...,
RESULTADO FICA PERFEITO.

Como teda regra, ha excegbes. Use com sabedoria essa dica.
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Parceiro de
Conteudo: ke

Corel na Veia

Corel - Convertendo objetos emimagens BITMAP

Alguns objetos, como gradientes, texturas, lentes e etc. devem ser
convertidos em imagens, ja que a transformacao somente em curvas nao vai
resolver possiveis problemas na hora da conversao. Para converter objetos
em imagens basta ir no menu Bitmaps e escolher a opgao Converter em
bitmap, ou entdo através do menu rapido"\".

Lembre-se de utilizar a op¢do Modo %e cor com "cor CMYK". E

importante também configurararesolucdo para

Converter em bitmap
Resolucho:
:ﬂ- S ——
Mpdode cor: | Cor CMYK (32 bit)

IMLERCD
Impressdo sobreposta de preto sempre
Opgdes
[¥] suavizacko de serrithads
[¥]Funda transparente

Tamanho do arguivo descompactado: 2.03 MB

[ o Cancelar | |  Apda
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Pls no minimo.

NOVO
PADRAO
MINIMO

Eu uso por padrido 1.200 DPIs, no entanto
depende do tamanho final do arquivo
PDF e da minha velocidade de
conexao com a internet para
eu poder subir no site o
pedido, entao, cada
caso e um caso.
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ERRADO

Resultado da impressédo de arquivo PDF
fechado sem converter degradé em imagem
enviado direto para producao.

_H}--_-T._!...L-'. i AHTE CANFCA LENEN

Resultado da impressao de arquivo
PDF fechado com todos efeitos
(incluindo degradé) em imagem

enviado direto para produgao.

CORRETO
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Versao Parceiro de Seja nosso
2016.01.06 Conteudo; #Parceirollustrator

lllustrator - Convertendo textos em vetor
Para converter um objeto em vetor va no menu Type e escolha a opcao
Creat Outlines.

Font

Recent Fonts
Size

Glyphs

ADOBE ILUSTRATOR

Type on a Path L
Threaded Text b
Fit Headline

Create Outlines Shift+Ctrl+0
Find Font...

Change Case k

Smart Punctuation...

Optical Margin Alignment
Show Hidden Characters Alt+Ctrl+]
Type Orientation »

Legacy Text L
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gl S R DIFERENCAS DE 4X0,4X1,4X4,1X0E 1X1 CORES
= L 1x0
As impressdoes em CMYK sdo feitas em quatro canais de cor (quatro
FRENTE VERSO pigmentos diferentes), o Ciano, o Magenta, o Amarelo e o Preto. Com a

: mistura destes canais (pigmentos) € possivel criar uma infinidade de cores.
= = 1x] Os numeros representam a quantidade de cores que serdo impressas
= em cadaum dos lados do papel, e sdoidentificados desta forma:

1x1 - Uma cor (preto) na
frente e uma cor (preto) no
verso: Devera ser utilizado

1x0 - Uma cor (preto) na frente:
"~ Devera ser utilizado o canal K do CMYK.
Escalas de cinza também resultam

N . 4xo

¢ o

g1 em uma unica cor (preto); apenas o canal K do CMYK.

= o Escalas de cinza também
cassca By M s resultam em uma tnica

&f‘“" f%; 4x1 cor (preto);
oY ==
FRENTE VERSO
ey, S
]
N, N x4
584 17
FRENTE VERSO
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4x0 - Quatro cores (CMYK) na frente

"en Eaer
= e verso sem impressao: Todas as

- \"H.._..-ﬂ‘ 1xu e

+ possibilidades de cor CMYK podem

. ser utilizadas na frente do material.
FRENTE VERSO » o 3 .
. 4 O verso nao recebe impressao;

FRENTE VERSO

4x4 - Quatro cores (CMYK) na
frente e quatro cores (CMYK)
no verso: Todas as possibilidades

FRENTE VERSO de cor CMYK podem ser
pmormd A o utilizadas na
N N 4x4 frente e no
. ' TT'I verso do
il e material.
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4x1 - Quatro cores (CMYK) na frente
e uma cor (preto) no verso: Todas as
possibilidades de cor CMYK na frente
do material. Para o verso, apenas o
canal de cor K do CMYK deve ser
utilizado;
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DIFERENCAS ENTRE IMPRESSAQ DIGITALE OFFSET
XEROX IGEN 4 A impressao digital é feita através do computador, onde o arquivo
é transferido diretamente para a impressora. Tiragens até 250 unidades
serdao impressas, em sua maioria, emuma impressora digital.

A impressao off-set e feita através da gravagao de uma chapa atraves
do CTP para cada um dos quatro canais de cor, que juntosirdo formar as cores
do produto final. A maioria dos produtos a partir de 500 unidades serao
impressas em uma impressora off-set.

PADROES/GABARITOS

Os padrdes/gabaritos sdao uma importante fonte de auxilio na hora de
produzir os materiais graficos. Nele o cliente pode conseguir as informacgdes
sobre margens de seguranca, linha de corte e sangria dos produtos. Cada
produto apresenta um padrao/gabarito diferente, portanto é
obrigatorio que se utilize o padrao correspondente ao produto
adquirido.

OFF-SET

Ligacao Gratuita 0800-042-004 4
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Exgmplo de Gabario para Caribed 8151 mm

= Frente

Example de Gabarito para Panfleto 10x15 om

= Frenta
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UTILIZANDO OS PADROES/GABARITOS

Os padrdes/gabaritos estdo disponiveis para download no nosso site
nos seguintes softwares: CorelDraw, Adobe Photoshop e Adobe Illustrator
(solicite no email LUIZ@GRAFICA.DESIGN arquivos padroes em Adobe
InDesign e QuarkXpress enquanto ndao houver adisponibilidade online).

Siga corretamente rigorosamente as instrucdes contidas nos padrdes
e sempre respeite as margens indicativas.

PDF/x1a

PROFISSIONAL LICENCIADO
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Exgmplo de Gabario para Caribed 8151 mm

= Frente

Example de Gabarito para Panfleto 10x15 om

= Frenta
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MARGEM DESEGURANCA, LINHA DE CORTE ESANGRIA

Sao importantes recursos para que o seu material seja impresso da
maneira correta, para que nao haja informacoes cortadas, ou entao areas
brancas aparecendo no produto final.

Sempre utilize os padrdes de todos os produtos para saber quais sao as
margensde seguranca, linha de corte e sangria.

Margem de seguranca

As margens de seguranca servem para que vocé tenha uma nogdo da
area do arquivo que nao sera cortada. Todas as informagées importantes
devem estar dentro desta area.

Linha de corte
As linhas de corte mostram aproximadamente aonde o
seu arquivo seracortado. N3o use esta linhapara demarcar
o fim da sua arte, nem coloque qualgquer informacao
nesta area, poisa mesma sera passivel de corte.

PROFISSIONAL LICENCIADO
I\YAdobe cOREL cPanel J§ Microsoft @
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Sangra

A sangra serve para ter a garantia que o fundo do seu arguivo
aparecera por completo, garantindo que nenhuma area branca apareca.

Esta area nao pode conter nenhuma "informacao importante”, pois o
corte pode variar, acarretando no corte da informacao.

Sangra
Lorte
Seglanc

Ligacao Cratuita 0800-042-004 4
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EXEMPLO DE PRETO CARREGADO:

Evite ao maximo este tipo de preto.

Caso voceé nao consiga diminuir a
cargar do ‘preto’, anexe em observacoes
ou envie mensagem dizendo:
“Carga de Cores: Tenho TOTAL ciéncia das
cores usadas! Ndo manipular o preto ou
cargas carregadas. Assumo o total
risco por manchas ou decalques.
PODEM SEGUIR COM PRODUGAOQ.”

Ligacao Cratuita 0800-042-004 4
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PRETO CARREGADO, PRETO FUNDO, PRETO PURO EPRETO LINHA

O preto é uma cor que merece um cuidado especial na hora da
impressao e na horadacriacdao do arquivo.

Na impressdo temos algumas orientagdes para cada um deles, e suas
particularidades devem ser respeitadas.

Preto carregado

O preto carregado € um tipo de preto que ndo aceitamos nas
impressoes.

Quando a soma de todas as cores superar 320%, este preto sera
carregado. Ou seja, uma carga muito grande de tinta sera liberada, fazendo
com que a impressao possa borrar ou entdaogrudar em outros papeis.

Caso o arquivo seja enviado com preto carregado, ele sera
colocado em pendéncia e sera solicitado para que o problema seja
resolvido pelo cliente. Somente apos o envio do arquivo
corrigido é que sera colocado em producdo. N3o iremos
produzir nenhum arquivo com preto carregado.

PROFISSIONAL LICENCIADO
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Preto Fundo |

Ciano 40%, Magenta 0%, Amarelo 0% e Preto 100%
4 0 0 1% Este preto é recomendado para ser utilizado no fundo das artes de

| | | . p— . Seus arquivos, e é indicado somente para impressoes off-set. Por conter um
C M Y K

pouco de Ciano em sua composicao, se ele for utilizado na impressao digital,
saira um preto com tom azulado.

PretoPuro |
Ciano 0%, Magenta 0%, Amarelo 0% e Preto 100%
0 0 0 100 O preto puro é recomendado para ser utilizado em textos ou curvas
IE. — . das artes de seus arquivos. Ele pode ser utilizado tanto em digital como em
— off-set. Ndo é recomendado o ser utilizado como fundo das artes, pois ele
C M Y K pode passar a ter um tom marrom escuro.

Preto Linha / Preto Contorno |

Ciano 1%, Magenta 1%, Amarelo 1% e Preto 100% -
Utilizado para proteger textos com fundo preto. Este preto

1 1 1 100
deve ser usado como contorno em seus textos quando eles
I I_. —_ . estiverem a frente de um fundo preto, pois a tinta podera
C M Y K "invadir" as outras cores na impressao. Com esta

protecao, seus textos ficardo maisnitidos.
Ligacao Gratuita 0800-042-004 4
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FUNDO
C40 M20 Y20 K100
E uma imagem
1.200 DPIs
combinada com
0 logo degradeé.

Todos os elementos tem ELEMENTOS BRANCO
borda C1 M1 Y1 K100 Permanecem em vetor
medindo 0,25 pts de
espessura

Ligocao Cratuita 0800-042-004 4
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Fundo
Preto
Carregado
o
Bordas
com Preto Puro
de Contorno
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Acabamentos - Corte Especial

O corte especial € um acabamento que permite que os produtos
possam ser cortados de formatos diferentes dos convencionais. Que tal um

cartao de visita redondo? Ou entdo triangular? Ou quem sabe ainda com um
formato totalmente diferente?

MODELOS DE CORTES ESPECIAIS
tag
Bilwd5 A4S BEwds B5mA7 cartiin dupia {80t ?
BOwdS Blmds BENA% BSmAT ——
B3k ?
Lats s
firda 16L
HExd5 BSxdS B5xdS AEadT BERAT
i ey — BSk47 e 47508
35KIS
FExdE AAxaT Bl ik LT
ree e P 1005 BEled7 A0
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Direto (11) 2368-0076 / 3042-2368
Whatshpp (1 1) 997-977-97 4
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0O acabamento de corte especial possui
algumas regras, dentre elas possuir uma area
de sangrade 2,5 mm pradentroe 1,5 mm pra fora.
E importante também evitar de fazer o envio de
facas muito complexas, com linhas muito
proximas umas das outras.
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DobraeVinco

Muitas pessoas confundem essas duas palavras, e assumem que sao a
mesma coisa, porem dobra édiferente de vinco.

A dobra e feita de maneira automatica através de uma
dobradeira, ja o vinco é feito através de um processo mecanico,
aonde uma maquina bate em uma area do material, formando
uma pequena "lombada" que sera dobrada.

A principal diferenca e que alguns materiais, quando
dobrados através deuma dobradeira, tem a sua ftinta
"quebrada", dando um aspecto esbranquicado no local, e
esfarelando a tinta. Ja os materiais que recebem o vinco tém essa
area preservada, deixando a impressao firme. Lembre-se que
essa diferenca se aplica somente para alguns materiais, ou
seja, se em nosso site a opgdo de dobra estiver liberada,
quer dizer que aquele material vai aceitar esse
acabamento sem problema algum.

Ligacao Cratuita 0800-042-004 4
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Para fazer corretamente os arquivos que ja possuem dobra e vinco
como acabamento incluso, baixe o padrdo e utilize as margens de seguranca

dedobra.
Utilize uma margem de seguranca de 5 mm para direita e

EVITE POSICIONAR TEXTOS para a esquerda da marcagao dadobra.
1]1) |NFOHMAGﬁEs IMPORTANTES E necessario fazer o espelhamento para saber como a
dobra ficara nafrente e noverso.
NAS AREAS EM VERMELHO:

- PARTE

PARTE F o

008RADARVERSOFRENTESR "Wny VERSO) FE™

PARA 1 LU EP:'-_H}'\ POSIVINCOD PR
DENTRO) TRy
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FURO
ESCOLHA AS OPCOES
3’ 5, ou 8 mm 0 furc:e um acai:famentn que g%ralmente e utilizado na prndug.?c: de
tags, ou entdao em etiquetas que vao ser usadas em lembrancinhas
amarradas por um corddo, ou em calendarios de parede. O furo deve
O O ficar dentro da area de seguranca, pois caso haja umavariacao no corte,

ofurondoseracortadotambém.

Escreva sua decisao no
campo de observacgoes
quando n3ao houver
opgoes a selecionar.

Insira Observacies se necessario:

N

Consulte sobre os itens que aceitam
furos no site ou envie um email para
LUIZ@GRAFICA.DESIGN
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‘ SERRILHA

SERRILHA
FRENTE

b iy

& [an!

€8 PARTE DA FRENTE E um acabamento que faz com que odestaque de alguma parte
do produto seja mais facilitado. Um exemplo é a comanda em que uma parte
ficacom o estabelecimento e a outra com o cliente.

MULHER

serrilha espelhada
Definicdo
@8 PARTE DO VERSO

Sequéncia de pequenos furos ou cortes muito unidos que, em folhas
de papel, servem para facilitar o seu corte manual.
SERRILHA

VERSO

| Utilizacao

A serrilha é utilizada em materiais como postais, folders, cartdes, tags
e outros. Este acabamento é de uso pratico, sua funcao principal é de facilitar
ocorte.

A indicacdo do local da serrilha & apenas indicada com um simples ponto na impressao,
local esse que deve ficar proximo a area de corte para sangrar na arte. Deve-se incluir no campo de

observactes “Serrilha estd indicada com uma linha pontilhada de espessura minima medindo
+- 5 mm em amarelo (usar qualquer cor que indique com nitidez) separando os quadrados com
fundo azul da area daimagem”.

Ligacao Gratuita 0800-042-004 4
Direto (11) 2368-0076 / 3042-2368
Whatshpp (1 1) 997-977-97 4
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SERRILHA

A serrilha possui uma margemde 2 mm para os lados da linha principal
FRENTE

de indicacdo. E necessdrio espelhar a arte, assim é possivel ter certeza de que
asinformacdesimportantes nao serdo cortadas.
@m PARTE DA FRENTE

MULHER &

A distancia minima da serrilha é de 2 cm, ou seja, a parte que vai ser
destacada ndo pode ser menor gue 2 cm.

serrilha espelhada

LOCAL DA SERFILHA
ESPELMADA
COM A& FRENTE
DO MATERIAL
P SERRILHA

: wwrw_Birthervonilher o oom_br

Dbserve este detalne
da marcacho da sedritha
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ESPELHAMENTO DE FACA, SERRILHA, DOBRA EVINCO

Os acabamentos de faca, serrilha, dobra e vinco merecem uma
atencdo especial na hora de serem produzidos. E necessario saber como
funciona o espelhamento, ja que o acabamento na frente sera espelhado no
verso. Vamos usarimagens para exemplificar:

Faca

Note que afacadafrente fica espelhada com afaca doverso. O arquivo
deve ser feito desta forma, para que se tenha certeza de como o verso vai
ficar em relacdo a frente. O resultado final, apds o corte, sera como mostrado
naimagem ao lado.

Ndo se esqueca também que o corte especial possui uma margem de 2
mm pradentroe 1,5 mm pra fora.

P

casasmagna
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A

casasmagna

atd & decoraglc

A

casasmagna

Erecha Etd B Gecotag

CARTAD DE WiSITA LAM I-'l'_.:"_-l:ﬁ 5] CARTAD DE VISITA LAM. FOSCA - 1S

wwn CRSASMagna
casasmagna
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Materiais de Constru ]
Materiais El tricos
Materiais Hidr ulicos
Ferramentas e Ferragens
Portas, Janelas e Port  es

Pisos e Revesimentos

Tudo o gue voce qur;
voci enconlra agui:

Materiais de Constru o
Materiais El tricos
Materiais Hidr  ulicos
Ferramentas & Ferragens
Portas, Janelas e Port  es
Pisos e Revesimentos
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r 1

O gque voce deve saber @ que
guando enviar a arte em formato retrato (em pé)

da frente sera encaixada 2

3 verso, deste modo: Acesse ao Video
como montar frente

e verso corretamente

8 base da arte
na base i

http://grafica.design/frenteverso

ol veas
vzzd

hittp:/fgraficanamooca . atualcand . com. br
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Mascara (Reserva de Verniz UV Localizado ou Aplicacdao de Branco
Especial Localizado)

A mascara serve para identificar o local onde um cal¢o ou um verniz
sera aplicado, seja ele verniz para um cartdao com verniz localizado, ou entao
um cal¢co para um cartao transparente ou metalizado.

Verniz Localizado (Mascara)

A mascara de verniz é utilizada nos produtos que é possivel a aplicagao
de um verniz localizado em uma parte do produto. E necessario o envio de
mascaras para que possamos saber aonde o verniz sera aplicado. A mascara
deve ser exatamente do mesmo tamanho do objeto que vocé quer o
acabamento.

Ex.: se o acabamento € em um texto, a fonte deve ser a mesma e o
tamanho também, assim como se for em uma imagem, a mascara deve ter
formato etamanho exatos.

FRFNTE

| Whaies Veteriaaria Fie Hasars

1
|
|
|
1
|
|
|
! e S TETIRTTEY SEtRL N e
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PVCTransparente + Branco

O cal¢o branco no PVC Transparente faz com que algumas partes do
produto fiquem opacas, ou seja, sem o efeito de transparéncia. O envio da
mascara & necessario pois precisamos saber aonde a sua arte ndo tera
transparéncia.

Metalizado

Assim como no transparente, o metalizado precisa de uma mascara
para gue o cal¢o seja aplicado, fazendo com que as partes calgadas nao
figuem com o efeito metalizado.

e S TETIRTTEY SEtRL N e

i Whisica Veiorinaria Fie Harars
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FRENTF MASCARA VERSO MASCARA

Vlinica Veterinaria Biv Bdzare

W volersnariasaclazare com br
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Imagem Cyan Imagem Magenta Imagem Black

€

TEXTO

F

Imagam Cyan Imagem Magenla Imagem Yellow
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Overprint e Knockout

A impressao sobreposta € uma opc¢ao de configuracao do
preenchimento de um objeto. Softwares graficos permitem essa
configuracao, algumas vezes até a impde, mas e preciso tratar essa
possibilidade muito cuidado e usa-la apenas se vocé tem certeza da sua
aplicacao.

Normalmente, na imagem gerada para a impressao, é deixada uma
“reserva” de papel em branco abaixo de cada objeto (imagem ao lado).

Repare que, mesmo havendo objetos coloridos abaixo do TEXTO, a
‘cores nesta area coberta pelo TEXTO ndo serdao impressas. O mesmo
‘acontece com o objeto em Ciano, a area que esta sendo coberta pelo objeto
‘Magentando serd impressa.

As cores sao separadas desta maneira para que apenas as partes
visiveis de cada objeto sejam impressas e o resultado final seja como visto na
tela.

Ativar a impressao sobreposta a um objeto faz com que as cores
desse objeto sejam impressas sobre as cores dos objetos que
estiverem abaixo.

Veja na arte ao lado como ficaria a separacdo das
cores para impressao, com a impressao sobreposta
ativada atodos os objetos.
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imagem Cyan imagem Magenta Imagem Yellow Perceba que, mesmo existindo o TEXTO cobrindo os objetos Ciano e
Magenta, os objetos serdo impressos por inteiro, sem a reserva. Isso fara com
que a cores se misturem no papel, resultando em uma Em situagdes onde

serao impressos textos, linhas ou pequenos objetor de cor escura sobre uma
| areadecor maisclara.
Tomaremos por exemplo a arte a seguir impressao muito diferente da
visualizada em tela.
Em caso de variacdo no registro (acerto das cores CMYK uma sobre a
outra), mesmo que pequeno, pode gerar uma pequena faixa sem impressao.
O resultado disso sao textos borrados e dificeis de ler.

’ Convites 5 | l I ks.
PopelariaPersonalizada
Convites Farbransay e w
Papelaria Personalizada & 9; v
A LS

Lembrancas

No caso dessa arte, a impressao sobreposta ativada nos
objetos em preto faria com que o preto fosse impresso
sobre as demais cores.
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Como o preto foi aplicado sobre as cores Ciano e
Amarelo, os objetos em preto sofrem mudanca na cor.

Como ativou ou desativo aimpressdo sobreposta?

No Corel Draw: Clique com o botdo direito do mouse
sobre o objeto e em seguida selecione “Impressao
Sobreposta do Preenchimento”

Como o preto foi aplicado sobre as cores Ciano e
Amarelo, os objetos em preto sofrem mudanca na cor.

Como ativou ou desativo aimpressao sobreposta?

No Corel Draw: Clique com o botao direito do mouse
sobre o objeto e em seguida selecione “Impressdo
Sobreposta do Preenchimento”

A confirmagao de que a Impressao Sobreposta foi
ativada fica evidente na barra de status. Uma marcacaoe
adicionada a cor do preenchimento ou contorno: [Jif]

@ & W como v 8o
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No InDesign

Existem duas formas de controlar as impressoes sobrepostas. Assim
como no lllustrator, a janela Attributes controla a Impressao Sobreposta do
objeto.

Por objeto:

Acesse o menu Attibutes: Window > Output> Attibutes
Com o objeto selecionado, a janela

W oane P - E-
: Fp? = - Q@M E—E Attributes mostra se a impressao sobreposta esta
| ¥ I - [ s b l 3 z
ativada para aquele objeto.
iy " ATTRIBUTES
St Cirle F10
E -
" A
o Particularidade do InDesign & que, por
" I X padrao, o software da saida a todos os objetos em
2 s Black 100% com impressao sobreposta. Isso
=} Preflgght - =Cirl=F ‘ X
b sepmions Preview sate | para evitar problemas de registro em
e Cirla W Trap Prasety

textos, por exemplo, que sendo
impressos em Black 100%
sobrepoe a gualguer outra
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Essa configuragao € ajustavel no menu
Edit > Preferences > Appearence of Black

r |
Preferences _— -
Gereral -  Appearance of Black
ADOBE -
INDESIGN Tyoa Options for Black on RGB and Grayscale Devices
d iT

S Ty On Screen: Diplay Al Biacks as Rich Black =

L incamens Printing / Exporting: Output All Backs Accurately - '

Grids

Guacies B Pastwbogrd Exasmple of 100K Black Example of Rich Black

H i

- HA HA

e, d d

Yates

Track Changes

S Ebbor Dias Overprnting of [Black]

Daplay Performance [¥ Qverprint [Black] Swatch at 100%

- . Descrpbion

Cptoe Hamiliey Dhacicing “Crverprint [Black] Swatch at 100%:" & best for printing o saving Fieched sepacations
wnd 3Fecs ondy cbjeos or mar coleresd with the [Black] (100K) swirch. Ths apples m PostSoen
and POF autpot, Linchecking the option will resait in all instances of [Black] knadiong oot
{remeving! undertying mis. sucept whaes & 5 apphad 00 an object pet o swerprint &5 fil o poroie,
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No lllustrator

ADOBE

“ ILUSTRATOR

MNew Window

Arrange
Workspace

Extenziont

¥  Control
v  Tools

Actions
Align
Appearance
Artboards
Attnbutes

Brushes
O Color
Coalor Guide

Document Info
Flattener Preview

Gradient
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Cerb+F11
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Fé
Shift+ F3

Crri=-F
Chatts FS
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Parceiro de Seja nosso
Conteudo: #Parceirollustrator

Acesse o menu Attibutes: Window > Attibutes

Com o objeto selecionado, a janela Attributes mostra se a impressao
sobreposta esta ativada para aquele objeto.

» Attnbutes

v Cwerprint Al
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POSSIVEIS VARIACOES

Por possuir uma producdaoem larga escala, algumas variacées nos
produtos podem acontecer. As variacoes podem ser de Cor, Refile e
Quantidade.

Cor

A variacdo de cor pode acontecer por conta do registro das
impressoras. As variagbes podem chegar a até 10% para mais da cor, ou
entdao 10% a menos da cor, ficando ela mais escura ou mais clara.

Estavariacdo aparece noresultado final.

PN PN

casasmagna casasmagna

P o SN

casasmagna

Bitores Mender Bitores Mendez Bitores Mendez

(oo TITFT-T77TT o0y TTT7-TT77 (oo TTT2-TTT7

W R (e W LA T L8 b

-10% | ORIGINAL +10%

Aimagem central é o arquivo original. Nota que aimagem
da esquerda ficou mais clara, representando a variacao de -
10% da cor original, ja a imagem da direita ficou mais
escura, representando avariagao de +10%.
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casasmagna

Bitores Mendez

ooy 7777-T777

bétare smende i Casssmagna com WWW _CELAYMAENA. Com, br

Bitores Mendez

(00) 7777-7T777
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Refile

O processo de corte envolve uma guilhotina que corta um bloco
inteiro com vdrias laminas de papel. Um pequeno movimento pode ser o
suficiente para variar a hora do corte, porém, como nossos padroes
possuem uma area de seguranca, as informacdesimportantessempre
serao preservadas.

Note que a imagem da esquerda recebeu o refile no local exato, e na
da direita o refile foi um pouco deslocado. Com essas imagens podem os ver
a importdncia das margens de seguranga, pois todas as informacdes
importantes serdo preservadas na hora do corte.

Quantidade
A quantidade também pode variar 10% a mais ou 10% a menos,
tendo em vista que sao feitas mais impressdoes para garantir a
quantidade exata, mas sabendo que problemas podem
acontecer, utilizamos esta margem.
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FECHAMENTO DO ARQUIVO

Estd é uma parte importante do processo, pois todo o arquivo deve
serverificado.

Tenha a certeza de que todos os elementos foram convertidos em

e: E D /x_la curvas, textos também convertidos em curvas e efeitos foram
transformados em imagens. Confira também se o seu arquivo esta em modo

/ CMYK, além disso veja se ndo existe um excesso de cor, formando preto

carregado ou entdo alguma outra cor muito carregada. Apos ter finalizado a
conferéncia, salve seu arquivo em PDF/X-1a.

NE@E@ BOOK
FECHAMENTO

DE ARQUIVOS
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SALVANDO EM PDF/X1-A

Para salvar em PDF/X-1a va no menu "Arquivo" e "Publicar em PDF".
Escolha o nome doseuarquivo e clique em "Configur.".

Mome: | pdfiila
Tipo: ;| POF - Portable Document Format (=, pdf)

CORELDRAW

Predefinicio de PDF: | ppe 15 =

Configur. Salvar Cancelar

“ Qoultar pastas
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"
il

Na opc¢dao Compatibilidade, escolha PDF/X-1a e logo em seguida
selecione, no menu superior, aaba Objetos.

Geral ICﬁr !Dm.mmm]ﬂ:pm]ﬁemm&aiSmm| :_@Nerl'mﬁwtln]

Nome do
arquivo:

Predefinicio de PDF: pareonalizado {configuracies atuaisnd.., v o =

Cmm! POF /X-1a -
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Na aba Objetos, deixe selecionada a opg¢dao Compactar texto e

linha artistica, mude as opcbes Cor para 800, Tons de cinza para 800 e
Monocromatico para 1200.

Feitoisso, clique em OK.

x|

. Compactaco do bitmap v Compactar texto e linha artistica
Tipo de compactacio: PEG v Exportar todo o texto como curvas
Qualidade JPEG; Texto e fontes

CORELDRAW | 2 || icompons

Alto Baixo g

|- Reamostragem do bitmap para menor — ie

v Tons de dnza [Bﬂﬂ -

|v Monocromation Llﬂi
Renderizar preenchimentos complexos  Arquivos EPS: | yisaizar
como bitmaps
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Versao Parceiro de Seja nosso
2016.01.06 Conteudo; #Parceirollustrator

SALVANDO EM PDF/X1-ANO ILLUSTRATOR

Cligue em File e escolha a opcao Save As...

Crl=M
Shifts Ctria M
Cirl=

e
Mew from Template.,
Cpen..

Browse in Brdge . A+ Cerl= 0
Clpze Chrd='W
have Crl=5
Save As. Shift+Cirl+ 5
5‘\' C .ﬁ 1-{ -tS -
=l gty Depois escolha o nome para o seu
Save ps Template...
Save for Web.. Al Shifts CtieS arquivo e escolhaa op¢ao Adobe PDF.
Save Selected Shices..,
v Home pefaia pd -
Mace. Tipo | Adobe POF [-PDR) =
Save for Microsoft Office. ; .
Exprt.. i el s I
Scripts
Document Setup. Akt Crri«P
Document Color Mode L
File Info... Alt= Shalt+ Crrd+ 1
Prnt... Cart+P
Extt Crl=Q

PROFISSIONAL LICENCIADO
I\YAdobe cOREL cPanel J§ Microsoft @




ADOBE ILUSTRATOR

Ligacao Gratuita 0800-042-004 4
Direto (11) 2368-0076 / 3042-2368
WhatsApp (1 1) 997-977-97 4

e-mail LUIZ@GRAFICA.DESIGN

B E B /GRAFICANAMOOCA

Versao Parceiro de Seja nosso
2016.01.06 Conteudo; #Parceirollustrator

Mude a opcao Adobe PDF Preset para PDF/X-1a:2001
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Versao Parceiro de Seja nosso
2016.01.06 Conteudo; #Parceirollustrator

Tenhacerteza de que na aba Output a opgao Destination estejacomo U.S.
Web Coated (SWOP) v2.

Em seguida clique em Save PDF.
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2016.01.06 Conteudo: #ParceiroPhotoShop

SALVANDO EM PDF/X1-ANO PHOTOSHOP

Cligue em File e escolha a opcao Save As...

Mew... - . Ctil=M
Cpen,, Ctri= 0
Broverse in Brdge... AR+ Ctrl=0
Browse in Mini Bridge..,
Cpen &s. Alt+Shift« Ctrl= 0
Open & Smart Object...
Open Recent
’ Close Cirl='W
ADOBE PHOTOSHOP o oA bk

Close and Go to Brdge... Shifts Ctrl« W

Save for Web... A+ Shat=Ctrl+ 5

-

Place...

Import
Export

Automate

Scripts
File Info.. A= Shift=Crie]

Print... Ctri+P
Print Oime Copy A+ Shift« Cirl+ P

Ext Cirl=0Q
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Parceiro de Seja nosso
Conteudo: #ParceiroPhotoShop

Depois escolha o nome para o seu arquivo e escolhaa opgao

Photoshop PDF

Photoshop POF [.POF,”.PLF

T AR,

Photoshop (.PSD:.* PDD)
Options Large Document Fomat (".FSE)
; EMP (".BMP;*.RLE;.DIB)

CompuSarve GIF [ .GIF)

Photoshop EPS (".EPS)

Photoshop DCS 1.0 (.EPS)

Photoshop DCS 2.0 (".EPS)

IFF Format (" IFF;” TDI)

JPEG (.JPG:" JPEG:".JPE)

JPEG 2000 (" JPF;" JPX;" JP2:" J2C;" J2K" JPC)

JPEG Stereo (TJPS)
Muiti-Picture Format (= MPQO)

wmonas ch r... F'C
Photoshop POF  PDF." PDP)

Photoshop Raw (" RAW)

Poaar (= PXR)

PNG " PNG:* PNS)

Portable Bt Map (" PBM:" PGM* PPM:" PNM:* PFM:* PAM)
Scitex CT (".5CT)

Targa (*. TGA;" VDA~ ICB~ VST)

TIFF (" TIF" TIFF)
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2016.01.06 Conteudo: #ParceiroPhotoShop

Mude a opcao Adobe PDF Preset para PDF/X-1a:2001.

Save Adobe POF ==
Adobe POF Presel: [PDF/X-13:2001) =
Standard: POF/X-12:2001 -

Compression
Descrption: s these settings to create Adobe PDF documents that are to be

Output checked or must conform to POF/X-12:2001, an 1SO standard for E
Sacurity graphic content axchange. For more information on craating POF-1a
complant POF documents, please refer to the Acrobat User Guide. -
Surmmary
Options
ADOBE PHOTOSHOP R

Optimize for Fast Web Preview
View POF After Saving

[ Save Preset... | (Save POE | | camcal
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Versao Parceiro de Seja nosso
2016.01.06 Conteudo: #ParceiroPhotoShop

Tenha certeza de que na aba Output a opgao Destination esteja como U.S.

Web Coated (SWOP) v2.
Save Adcbe PDF =
Adobe PDF Preset: [POF/X-13:2001] -

atandard:  PDFMX-12:2001

Genaral Dutput
Compreszion Calar
_ Color Conversion: Conwert to Destmation -
Security
Summany Destnation:  LLS. Web Coated [SWOR) v2 -
ADOBE PHOTOSHOP
PDF/X
Dutput Intent Profie Name: 11,5, Web Coated [SWOPR) vZ -

Qutput Condibion:
Output Condition Identher:  CGATS TF

Repgistry Name: | it

Description

[ Save Preset.... | Cancel

Apos ter seguido estes passos, clique em Save PDF,
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Obriga
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